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1 Safety Messages and Proper Use of the Data
Visualizer

1.1 Important Definitions
The types of messages shown below serve the safety of life and limb as well as for the
appropriate operating life of the device.

DANGER!

DANGER! indicates an immediately dangerous situation that will result in death or
serious injury if it is not avoided.

WARNING!

WARNING! indicates a hazardous situation that can result in death or serious injury if it is
not avoided.

CAUTION!

CAUTION! indicates a possibly hazardous situation that can result in minor or moderate
injuries if it is not avoided.

NOTICE!

NOTICE! is used to address practices not related to personal injury.

This symbol indicates useful tips and recommendations as well as information for
efficient and trouble-free operation.
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1.2 Proper Use of the Device and of This Manual

WARNING!

FOLLOW INSTRUCTIONS

Read this entire manual and all other publications pertaining to the work to be performed
before installing, operating, or servicing this equipment. Practice all plant and safety
instructions and precautions. Failure to follow instructions can cause personal injury
and/or property damage.
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1.3 Important Information
Out-of-Date Documentation?

This publication may have been revised or updated since this copy was produced. To
verify that you have the latest revision, please visit the download section of our website:

• https://docs.SEGelectronics.de/smart_view•

Please check this download area for the latest revision of this Technical Manual and
whether there is an Errata Sheet with updated information. (The ID of every document is
printed on its cover page.)
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2 Introduction to the DataVisualizer
The DataVisualizer is a universal tool for evaluation of disturbance records, i. e. currents
and voltages in case of a fault or at other times stipulated by the user. The DataVisualizer
evaluates the disturbance records stored in the individual control devices. With this program
it is possible to visually display, process, store and print disturbance records in their
chronological progress (as oscillographic curves) with the appertaining events (such as
tripping, alarm, etc.).

The DataVisualizer offers:

• Analysis of the fault•

• detection of the faulty consumer•

• the reaction of the grid and•

• the switch-off behavior of the circuit breaker•

This information provides the user with the basis for the analysis of faults and weak points
of his electrical equipment.

On this basis the following is possible, for example:

• to adjust or revise circuit breakers•

• to limit short circuit powers•

• to optimise transformers (capacity / uK)•

• to adjust converters (saturation behaviour)•

Installation of the DataVisualizer

System requirements:

Windows 7, Windows 8.x or Windows 10

The DataVisualizer does not need a separate installation process, because it is always
installed along with Smart view.

If DLLs should be Missing

If Data Visualizer should refuse to start because of missing DLLs then your Windows PC
needs to have the “Visual C++ 2017 Redistributable (x86)” package installed.

You can get this package either from our download area at docs.SEGelectronics.de/
vc_redist_x86, or directly from Microsoft.

Uninstalling DataVisualizer

The DataVisualizer does not need a separate uninstall process, because it is always
removed together with Smart view.
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A file is imported via the menu item [File / Open Existing Disturbance File] (see ╚═▷ “File
Menu”), or via the corresponding button [1] (see ╚═▷ “Button Bar”).

The supported files can have the following suffixes:

• HighPROTEC file formats:•

◦ *.HptDr — disturbance records◦

◦ *.HptSr — start records◦

◦ *.HptTr — trend records◦

• HighTechLine file formats:•

◦ *.dsb◦

◦ *.cfg◦

The DataVisualizer selects the appropriate input filter, and after the file has been loaded
successfully, the channels are shown on the Tree Structure Panel, sorted into categories
such as Analog Channels, Digital Channels, and so on.
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3 DataVisualizer’s Main Window
The DataVisualizer is a universally applicable tool for displaying fault and system records.

Structure of the Main Window

①
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Fig. 1: DataVisualizer main window.

① Tree Structure Panel.

② Operating Panel.

The buttons on the toolbar are described here: ╚═▷ “Button Bar”
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Button Bar
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• [1] Open a disturbance record.•

• [2] Freeze view: Store the current view settings of the loaded disturbance file.•
(A new file with the extension *.snp – snapshot – is created.) Depending on the
preferences (╚═▷ “Preferences Menu”) these settings are automatically adopted
again when the file is loaded.

• [3] The width of the time axis depends on the window size and gets automatically•
adjusted if the window dimensions are changed. (If this option has not been
chosen, this resolution can be set in the preferences in addition to others, see ╚═▷
“Preferences Menu”). This is deactivated automatically during zooming.

• [4] If the mouse is located within the working panel and this option has been•
activated, a small panel is displayed with the »measured values« at the mouse
position (if the mouse is not moved for about 1 second). (See also ╚═▷ “Show
Measured Data”.)

• [5] Switch the labelling of the time axis on or off.•

• [6] Modify the low offset of the digital channels.•

• [7] Switch the marking of the sample points on or off. (See also ╚═▷ “Show Sampled•
Data”.)

• [8] Display the analog channels with or without grid.•

• [9] Time slider: A cursor (green vertical line) is shown. Press and hold down the•
left hand mouse key over the green line. Keep holding down the left hand mouse
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key and move the mouse pointer along the time line. All measured values of the
displayed channels are indicated in a window for the respective cursor position. (See
also ╚═▷ “Momentary Values”.)

• [10] Switch back to display without zoom (original size).•

• [11] This option zooms the display of all channels.•

• [12] Switch back to the next lower (previous) zoom stage.•

• [13] Two cursor lines are shown. Press and hold down the left hand mouse key•
above these lines and move them according to the interval you want to zoom in. By
means of the blue line you can define the start and by means of the red line you can
define the end of the time interval. By pressing button [14] the DataVisualizer zooms
into the interval that you have set. (See also ╚═▷ “Zoom”.)

• [14] Stretch the time axis onto the time range between the two cursors [13].•

• [15] Print the currently displayed channels.•

• [16] Open the online help.•
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[File] Menu

①
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Fig. 2: Menu items in the [File] menu.

① Open or import an existing disturbance record file. See ╚═▷ “DataVisualizer Start” for
supported file types.

② Select to re-open a previously opened file.

③ Freeze view, see button [2].

④ Export the currently loaded file to ASCII, Look or COMTRADE file format.

⑤ Print.

⑥ Print preview.

⑦ Quit the DataVisualizer.
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[Preferences] Menu

HelpOK Cancel
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Preferences

Display Printing Freeze view Fonts Language

Height of an analog channel (pixel)

200

Width of an analog channel (pixel)

1188

Automatic channel display

Automatically display analog and digital channels according to filters:

Display ANSI Device Numbers
Enable (if supported by device)

Edit filters...

Some settings can be changed permanently. For this purpose select the menu item
[Preferences / Edit]. These settings are stored so that they become effective again with a
subsequent (re-)start of the DataVisualizer.

Display

• The screen resolution (width and height of the analog channels) can be adjusted.•
The size of digital and logical channels depends on the font chosen for the display.

• An automatic filter can be added and defined for the analog and digital channels•
(╚═▷ “Automatic Channel Display”).

• The display of the ANSI Device Numbers can be enabled. This setting works only•
if the device supports it. If this setting is changed when channels are already
displayed, the change becomes effective only if the file is reloaded.
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Preferences

Display Freeze view Fonts LanguagePrinting
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Print margins (mm) Height of an analog channel (mm)
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Printing

• The paper margins can be adjusted for printouts.•

• Furthermore, the height of the analog channels can be specified in millimeters.•

HelpOK Cancel

Preferences

Display Freeze view Fonts LanguagePrinting
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Preferences

Load view settings (freeze view) at start

Save view settings before exit

Ask before overwriting view settings

Automatic

Automatic

Freeze View

• These settings define the storage of the currently selected display parameters.•

A snapshot stores all displayed channels as well as their order. These are then
available when the file is loaded again.
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Display Printing

Display:

Header:

Footer:

Freeze view

Display

Header

Footer

Fonts Language

Select

Select

Select

Fonts

• The fonts for display and printing are adjusted.•
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The displayed height of the digital and logical channels is adjusted as a function of
the chosen fonts.
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Display Printing Freeze view Fonts Language

German (Germany)
English (USA)
Spanish (Spain, traditional)
French (France)
Polish (Poland)
Portuguese (Brazil)
Romanian (Romania)
Russian (Russia)

Select desired language

The new language setting will take effect after a restart of the
application!

Language

• The language that DataVisualizer uses can be selected.•

A change, however, becomes effective only after a restart of the DataVisualizer.

[Help] Menu

The [Help / Help] menu item launches the DataVisualizer online-help.

The [Help / Program Information] menu item launches a window that displays
DataVisualizer-related version and copyright information.

Function of the Mouse Pointer

• If the mouse is not moved inside the operating window, the appertaining sample•
number and time are shown. If the respective button is active, the measured values
of the channel underneath the mouse will be displayed.

• If the mouse position gets near the cursors (Button bar [9] or [13], ╚═▷ “Button Bar”)•
the pointer changes and these cursor lines can be shifted by keeping the left mouse
button suppressed.

• If the left mouse button is pressed on a display, a section can be zoomed. If the•
mouse is moved while the left mouse button is being pressed, it is possible to fix the
section to be zoomed. There are two cursors which indicate during marking whether
this zoom rate is permissible. (Zoom OK, Zooming not possible as this would exceed
the maximum resolution of 32000 × 32000 pixels.) Zooming can be aborted with
the »ESC« key.

• If the right hand mouse key is pressed and the display is larger than the screen•
section, the mouse pointer changes into a hand symbol. If the mouse key is held
down the shown section can be moved.
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4 The Tree Structure — Handling Displayed
Channels
Add Channels to the Operating Panel
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Additional channels can be dragged from the Tree Structure Panel onto Operating Panel
(with the left-hand mouse button pressed).

During this procedure the mouse pointer changes and indicates how this channel is going to
be displayed:

• 1st possibility:  — A new graph is added in this place.•

• 2nd possibility:  — The curve is added to the existing graph. (Note that only•
analog channels can be combined).

• 3rd possibility:  — It is not possible to add the channel to this position.•

Further channels can be added the same way.

It is also possible to select several channels at a time (with the »Ctrl« key being pressed),
then drag and drop them all at once.
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Remove Channels from the Operating Panel

If you want to remove channels from the display, select and do a right-mouse-button click on
the channel to be removed in the tree structure (displayed channels). (It is possible to select
several curves the usual way, by keeping the »CTRL« key pressed.)

Then press the »Delete« key.
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Fig. 3: Remove channels.

Alternatively, the channels can be removed with the following procedure:

① First select the channels with the left mouse key (multiple choices by means of the
pressed and hold down »CTRL« key respectively »Shift« key are possible).

② Then do a right-mouse-button click on any selected channel and select the
option »Remove« from the context-menu.

The context-menu of the parent-branch in the Tree Structure also offers the option »Remove
all« or »Remove group«. These remove all subordinated channels at once.
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Automatic Channel Display

It is possible to enable option to automatically display certain channels after opening a new
file (see: [Preferences / Edit] → Display → Automatically display analog and digital channels
according to filters, ╚═▷ “Preferences Menu”).

Channels to be added added are defined by filters, that are set in a separate dialog. There
are separate filters for analog channels and changed digital channels (see: [Preferences /
Edit] → Display → »Edit filters«).

It is possible to either a default filter set or a user-defined filter set.

Note: If a “snap shot file” exists for a recently opened file (see [Preferences / Edit] → Freeze
view), then the stored view from this “snap shot file” is used for the channel display. In this
case the automatic channel display is ignored.

Defining filters: A filter definition consists of several channel names that are entered, each
on a separate line, into the text field of the dialog. Each line entry will generate a new
diagram. (Exception: The comma character, see “Analog channels” below.) The matching
mechanism is case-sensitive, and also space (blank) characters do count. It is possible to
use wildcards in filter definitions to match several channel names to be added. An asterisk
character “*” represents any number of any characters in the filter definition. (See some
examples below.)

Analog channels: Usually channels matched by a filter are added one underneath the other.
In case of analog channels it is possible to have some channels being displayed overlapping
on one graph. To achieve this, a “,” (comma) character must be used. If several channel
filters appear in one line, each separated one from another by a comma, then all matching
channels will be displayed in one graph. But if some of these channel(s) shall be forced onto
a new graph (underneath the previous one) then this can be achieved by starting this part
of the filter definition on a new line (see Example 3 below).

Digital channels: In case of digital channels it is not possible to have multiple overlapping
channels on one graph. Therefore all digital channels are always added one underneath
the other no matter which character (comma or »new-line«) is used to separate the
filter definitions.
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V*
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Displayed channels
VT . VL1  / VL12 
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HelpOK Cancel

Display filter configuration

Default filter set
User filter set

Analog channels:

Changed digital channels:

V*

Filter configuration

Filter definitions

Fig. 4: Example 1 : Filter = V*

Example 1 : Filter = V* — When the file is re-opened the matching channels are displayed
(all separately, one graph below the other).
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Example 2: Filter = V*, — When the file is re-opened the matching channels are displayed
(all combined in one graph).
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Fig. 6: Example 3: Filter = V*,»new-line« CT Mains . I L*

Example 3: Filter = V*,»new-line« CT Mains . I L* — When the file is re-opened the
matching channels are displayed, with the voltage curves being combined in one graph,
and the current curves being combined in a second graph that is placed underneath the
voltage graph.
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5 Display of Channels and Measured Values
Show Channel Information

Click on the required channel in the Tree Structure Panel.

Clicking »Info« opens a list that shows all measured data as a table.

Change the Color of the Channel Display

Click on the required channel in the Tree Structure Panel.

Clicking »Color« opens a palette where you can select the color to be used for displaying
the curve.

Zoom

The displayed curves can be zoomed so that more details can be seen.

First, there are buttons [11] and [12] (see ╚═▷ “Button Bar”) that enlarge (or shrink,
respectively) all curves horizontally and vertically by some fixed magnifying factor. Buttons
[10] resets this magnification to the original size.
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Fig. 7: Stretch time axis, steps 1 and 2.

There is, however, also another useful feature that allows to increase the resolution of the
time axis:

① First, select the »Two cursor lines« button [13] (see ╚═▷ “Button Bar”).

② Move the time sliders with the mouse to adjust the left and right borders of the area to
be shown.
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③ Finally click the »Stretch time axis« button [14] to enlarge this area.

④ The two time sliders move to the left-most and right-most positions, respectively.

This way it is possible, for example, to enlarge a small time interval to the greatest possible
resolution and find the point in time where the curve crosses the time axis.
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Fig. 8: Stretch time axis, step 3.

Show Sampled Data
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Fig. 9: Marking of the sampled points.
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The »Marking of the sample points« button [7] toggles the visibility of the sample points.
Note that this does not enable you to edit the sample points, this button only controls
the visibility.

Show Measured Data

Independent of the visibility of sample points you can also activate the »Measured
Values« button [4]. Then the sampled data is shown when the mouse pointer hovers over
some point of a curve.
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Fig. 10: Show Sample values.

① You can use the »Time slider« button [9] (see ╚═▷ “Button Bar”) to activate/deactivate the
momentary-value/time-slider mode.

② If this mode is active, a green vertical line pops up within the Operating Panel.
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③ If this line is moved along the time-axis (with the left-hand mouse key being pressed)
all measured values according to the current position of the time slider are displayed in a
separate window.

Copy and Paste Channels
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Fig. 11: Copy/paste a curve (as a bitmap).

① Select and do a right-mouse-button click on the required channel in the tree structure
(category »Displayed channels«).

② A context-menu opens that offers the option »Copy«.
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③ This option copies the curves as an image to the clipboard, so that they can be pasted (the
usually way, e. g. with »Ctrl«+»v«) into some document.
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